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Customer Appointment Manager

Software License Agreement
PLEASE READ THIS DOCUMENT CAREFULLY

BEFORE USING THIS SOFTWARE

By using this computer program (“Software”), you agree to become bound by the terms of this License. If you do
not agree to the terms of this License, do not use the Software and promptly return the package within 10 days to
the place where you obtained it for a full refund.

This Software is licensed, not sold to you (owner of the product) by Atlas Business Solutions, Inc. (“ABS”), for use
only under the terms of this License, and ABS reserves any rights not expressly granted to you.

1.  Single-user License.  This License allows you to:

(a) Use the Software on a single microcomputer at a time, except the Software may be executed from a common
disk shared by multiple CPUs provided that one authorized copy of the Software has been licensed from ABS for
each CPU executing the Software. ABS does not, however, guarantee that the Software will function properly in
your multiple-CPU, multi-user environment. The Software may not be used with any gateways, bridges, modems,
and/or network extenders that allow the Software to be used on multiple CPUs, unless one authorized copy of the
Software has been licensed from ABS for each CPU executing the Software.

(b) Make one copy of the Software in machine-readable form solely for backup purposes. The Software is pro-
tected by United States copyright law. You must reproduce on each copy the copyright notice and any other
proprietary legends that were on the original copy supplied by ABS.

2.  Multi-user License.  This License allows you to:

(a) Use the Software on multiple microcomputers at a time. The maximum number of users is limited to the number
indicated on your multi-user license card. The Software may be executed from a common disk shared by multiple
CPUs or terminals provided that one authorized copy, or license, of the Software has been purchased from ABS for
each CPU or terminal executing the Software. ABS does not, however, guarantee that the Software will function
properly in your multi-user environment. The Software may not be used with any gateways, bridges, modems, and/
or network extenders that allow the Software to be used on multiple CPUs or terminals, unless one authorized
copy, or license, of the Software has been purchased from ABS for each CPU or terminal executing the Software.

(b) Install the Software on one computer for each license purchased, unless the computer is a server providing
multi-user capabilities using Citrix Metaframe, Windows Terminal Server, or similar products (Application Server). If
the software is to be installed on an Application Server, license is required for each unique user connecting to the
Application Server.

(c) Make one copy of the Software in machine-readable form solely for backup purposes. The Software is pro-
tected by United States copyright law. You must reproduce on each copy the copyright notice and any other
proprietary legends that were on the original copy supplied by ABS.

3.  Restrictions:

You may not distribute copies of the Software to others or electronically transfer the Software from one computer to
another over a network and/or zone unless one authorized copy of the Software has been licensed from ABS for
each CPU executing the Software. The Software contains trade secrets and to protect them you may not
decompile, reverse engineer, disassemble, cross assemble or otherwise change and/or reduce the Software to any
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other form. You may not modify, adapt, translate, rent, lease, loan, resell for profit, distribute, network or create
derivative works based upon the Software or any part thereof.

4.  Termination:

This License is effective until terminated. This License will terminate immediately without notice from ABS if you fail
to comply with any provision of this License. Upon termination you must destroy the Software and all copies
thereof. You may terminate this License at any time by destroying the Software and all copies thereof.

5.  Export Law Assurance:

You agree that the Software will not be shipped, transferred, or exported directly into any country prohibited by the
United States Export Administration Act and the regulations thereunder nor will be used for any purpose prohibited
by the Act.

6.  Limited Warranty, Disclaimers, Limitation of Remedies and Damages:

ABS’ warranty on the media, including any warranty of merchantability or fitness for a particular purpose, is limited
in duration to thirty (30) days from the date of the original retail purchase of this product. After that period, if a disk
fails to work or if a disk becomes damaged, you may obtain a replacement disk by returning the original disk.
Contact ABS for instructions on obtaining replacement disks.

The replacement warranty set forth above is the sole and exclusive remedy against ABS for breach of warranty,
express or implied, or for any default whatsoever relating to the condition of the Software. ABS makes no other
warranties or representation, either expressed or implied, with respect to this Software or documentation, its
quality, merchantability, performance, or fitness for a particular purpose. As a result, this Software is sold with only
the limited warranty with respect to diskette replacement as provided above, and you, the owner, are assuming all
other risks as to its quality and performance. In no event will ABS or its developers, directors, officers, employees,
or affiliates be liable for direct, indirect, special, or consequential damages (including damages for loss of business
profits, business interruption, loss of business information and the like) resulting from any defect in this Software or
accompanying documentation or arising out of the inability to use the Software or accompanying documentation
even if ABS, an authorized ABS representative, or an affiliate has been advised of the possibility of such damage.

No oral or written information or advice given by ABS, its dealers, distributors, agents, affiliates, developers,
directors, officers, or employees shall create a warranty or any way increase the scope of this warranty. Some
states do not allow the exclusion or limitation of implied warranties or liabilities for incidental or consequential
damages, so the above limitation and exclusion may apply to you. This warranty gives you the specific legal rights,
and you may also have other rights that vary from state to state.

7.  Copyright Notice:

This Software and accompanying manual (or documentation) are copyrighted with all rights reserved by Atlas
Business Solutions, Inc. Under United States Copyright Laws, the Software and its accompanying documentation
may not be copied in whole or in part, except in normal use of the Software or to make a backup copy for archival
purposes only. Any other copying or selling or otherwise distributing this Software is hereby expressly forbidden.

Copyright Information
Copyright © 2008 by Atlas Business Solutions, Inc. All rights reserved. Reproduction of this User Guide or
Software, in whole or in part, without permission of Atlas Business Solutions, Inc. is strictly prohibited.
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What is Customer
Appointment Manager?

Customer Appointment Manager is the fastest, most user-friendly software for managing appointments. It
will show you who’s available and when, and let you book appointments in seconds. No more putting cus-
tomers on-hold or having them stand around while you search for an appointment. Everything you’ll need to
promptly schedule customer appointments is right at your fingertips in this easy-to-use, electronic appoint-
ment book.

You’ll spend less time scheduling appointments with Customer Appointment Manager. Quickly add or
locate existing customers, find available appointment times (by employee, time period, or both), and schedule
a one-time or repeating appointment, all with just a few clicks of  your mouse. Imagine being able to handle
your appointments with the same speed and efficiency as the rest of  your business.

Customer Appointment Manager’s point-and-click navigation and intuitive design make it easy to learn
and use, even for first-time computer users. Its user-friendly and visual layout means easy access to all the
information and features you’ll need to efficiently manage your appointments. If  you’ve been using a paper
appointment book, or some other software that’s not getting the job done right, you’ll be pleased you made
the switch to Customer Appointment Manager.
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With Customer Appointment Manager you can:

• Schedule customers in seconds; one-time or repeating appointments

• See who’s available and when, plus find open times quickly

• View appointments by day, week, or month

• Email customer appointment reminders

• Fill cancellations and no-shows from waiting list

• Print daily appointment sheets, appointment reports, and more

• View and print customer appointment history

• Increase staff  utilization and improve customer service

• Store customer photos (Pro edition only)

• Monitor employee and business performance (Pro edition only)

• Take appointment requests online (Pro edition only)

• Track appointment changes (Pro edition only)

Included in the new version 4.0:

IMPROVED  Employee Work Schedules – Enter your employees’ work schedules to make sure appointments
are only scheduled on days they’ll be working. It’s easy to accommodate temporary or permanent changes to
an employee’s work schedule, such as summer or holiday schedules.

NEW  Custom Column Widths – Adjust individual column widths to maximize the viewing of  appointment
information.

IMPROVED  QuickBooks Integration – Instead of  importing all of  your customers from QuickBooks, you
can choose to skip inactive customers.

IMPROVED  Performance – Whether you have hundreds, or even thousands of  customers, customer lists load
faster making it easier to find customers and schedule appointments.

NEW  Undo Feature – Now you can undo common tasks like cut, copy and paste, as well as reset appoint-
ment lengths and restore moved appointments.

NEW  Employee Move Feature – Simply drag and drop employees to where you would like them to appear on
the screen.

IMPROVED  Employee Sorts – Sort employees by first name, last name or position, or create a custom sort by
dragging and dropping employees.

IMPROVED  Letters Publishing – Insert custom fields into your letters to create tailored marketing messages
and to improve customer communications.



Customer Appointment Manager

Chapter 1:  What is Customer Appointment Manager? 3

NEW  Services Sort Option – Move services up and down in the services selection window to make picking
services faster.

NEW  Daily Notes – Add a note to an employee’s daily schedule. Notes can be viewed on-screen and on
reports.

NEW  Audit Trail (Pro edition only) - Easily track changes made to appointments by individual users. See who
scheduled or deleted an appointment, made changes to appointment times, descriptions, services, and more.
Only user’s granted administrator rights within Customer Appointment Manager Pro can view this informa-
tion.
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What You Need to Run Customer Appointment Manager

The minimum software and system configuration you need to run Customer
Appointment Manager includes:

• A personal computer with a Pentium Processor (75+ MHz) and at least 256 MB of memory.

• CD-ROM drive and a hard disk, with at least 40 MB of  free disk space for program files, plus additional
disk space for data files.

• Windows operating system: 2000/NT*/XP/Vista.

• A mouse supported by Microsoft Windows 2000 or higher.

• A monitor supported by Microsoft Windows 2000 or higher.

• An optional printer supported by Microsoft Windows 2000 or higher.

• 1024 x 768 screen resolution or higher.

• Internet access for accessing online appointment requests (DSL or cable modem recommended - Pro
edition only).

*NT is supported only when acting as a server in multi-user, client/server environments.

2

Installing Customer
Appointment Manager
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Installing Customer Appointment Manager

If  you purchased a multi-user version of  Customer Appointment Manager, install the software on each
individual workstation. Be sure you are logged in as “Administrator” or have administrative rights to install the
application. We also recommend that you close all applications, including screen savers or similar programs,
before running the Setup program.

Install Customer Appointment Manager for Microsoft Windows
2000/NT/XP/Vista

Follow the instructions listed below to install Customer Appointment Manager using Windows 2000 or higher.

1. Insert the Customer Appointment Manager CD into your computer’s CD ROM.

2. The Setup program should run automatically. If  not, complete the following steps.

l Click the Start button.
l Select Run from the Start menu. The Run dialog box is displayed.
l Type d:\Setup.exe in the dialog box (use the appropriate drive letter for your CD-ROM).
l Click OK or Press the Enter key.

Note: The Setup program cannot run automatically if  Autorun is inactive.

Customer Appointment Manager will display the Setup dialog box. Complete the setup by following these
steps:

1. Click Next at the Welcome Screen and the License Agreement is displayed. Read it and click Next to
accept it.

2. The Installation Options screen appears. Select the Anyone who uses this machine option to allow other
users to access the Customer Appointment Manager application on your PC. Or, select the Only for
me option if  you are the only user that should access the Customer Appointment Manager application
on your PC. Click Next.

3. The Destination Location window is displayed. The Setup program will install Customer Appointment
Manager software to the directory c:\Program Files\Customer Appointment Manager. It will
automatically create the directory on your hard disk, if  you haven’t done so already. To install the
program to another directory click Browse and enter or select a destination directory. Click Next.

4. The Start Installation screen is displayed. Click Next, and Customer Appointment Manager starts
copying the program files to the designated directory and updates the system configuration.

5. The Setup program notifies you that Customer Appointment Manager has been successfully installed.
The Setup program automatically adds Customer Appointment Manager to Start > Programs > ABS
Applications group.
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6. Click Finish and the Setup program will add a Customer Appointment Manager shortcut to your
desktop.

7. Start Customer Appointment Manager application by double-clicking the desktop shortcut.

Install Multi-User Versions of Customer Appointment Manager for Microsoft Windows
2000/NT/XP/Vista

1. Follow the instructions listed on pages 7 and 8 of  this chapter to install a multi-user version of
Customer Appointment Manager using Windows 2000 or higher.

2. The Customer Appointment Manager Network wizard is automatically launched when Customer
Appointment Manager runs for the first time on a workstation. This wizard is used to setup the
location of  the database, and to share that folder.

3. If  this is the first time a multi-user version of  Customer Appointment Manager is installed to a
computer on your network, then you will need to select option 1; if  not, select option 2.

Continue setup with the option 1 or option 2 procedure.

Option 1: Setting up a New Customer Appointment Manager Database

1. Click Next, after selecting option 1.

2. The database will be installed to the directory, C:\CustAppMGR folder. To install the database to
another directory click Browse and select a destination directory. Click Next. To create the directory, click
Yes.

3. Click the Share button to share the folder. The CustAppMGR Folder Properties dialog is displayed.

l Windows XP Home/Pro (with Simple File Sharing):
Mark the Share this folder on the network and Allow network users to change my files check boxes,
Then, click Apply and OK.

l Windows XP Pro/ NT / 2000:
Select the Share this folder option, then select the Maximum allowed option in the User limit field.
Click Apply. Next, click the Security tab and select Users or Everyone, and give full control by
marking the Full Control check box.

4. Click Next.

5. Click Finish. Customer Appointment Manager is automatically launched.
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Option 2: Connecting to an Existing Customer Appointment Manager Database

1. Click Next, after selection option 2.
2. There are two options for connecting to an existing Customer Appointment Manager database:

l Automatically search for all Customer Appointment Manager database folders. This option may
take a few minutes. Once all folders are displayed, select the appropriate folder. Then, click Next
and Finish.

l Choose to manually specify the location of  a Customer Appointment Manager database folder.
Click Browse to select the folder that contains your Customer Appointment Manager database.
Click OK, then Next and Finish.
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Getting Started

With its user-friendly design and point-and-click navigation, Customer Appointment Manager is easy to
learn and set up, even for first-time computer users. After installing Customer Appointment Manager,
review this chapter to learn about using the:

l Menu Bar

l Tool Bar

l Appointment Book

l Calendar

l Appointment Detail

l Waiting List

l Appointment Requests

l Database Maintenance

l View Audit Trail

l and other features

When you’re ready to start scheduling appointments, you’ll be up and running after completing a brief  setup.
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Using Menus & Tools

After you’ve installed Customer Appointment Manager, review the menus and tools so you become
familiar with the program’s features. The pages in this chapter provide you brief  descriptions to help you
learn the locations of  the features you’ll use to make appointment scheduling quick and easy.

Menu Bar

In Customer Appointment Manager, access options in your menu bar by:
• navigating with your mouse, click on the menu name
• using your keyboard, press the Alt key plus the underlined letter of  the menu name

File menu:
Use this menu for maintaining information records, importing employees and customers from
QuickBooks, deleting old appointments, adding and maintaining custom fields, importing and
exporting customer data from other files, viewing audit trail (Pro edition only), backing up and restoring
Customer Appointment Manager, printing appointment calendars, and exiting the program.

Edit menu:
Use this menu for cutting, copying, pasting, editing, using undo, and deleting appointments, as well as
moving appointments to the Waiting List.

View menu:
Use this menu for selecting day, week, or month calendar views, finding open times, searching for
appointments, zooming the view size, and refreshing the calendar (multi-user versions only).

Tools  menu:
Use this menu for setting your appointment calendar options, generating customer email lists and
appointment reminders, creating and printing mailing labels, emailing appointment information to
employees, creating or editing letters, and accessing online appointment requests (Pro edition only).

Reports menu:
Use this menu for viewing and printing the Daily Appointment Sheet, Appointments by Employee,
Appointments by Customer, Employee Productivity, Services Summary, Waiting List, and Customer
List.

Charts menu (Pro edition only):
Use this menu for viewing and printing pie charts that display Services Summary and Employee
Productivity, and bar charts that display Appointments Summary and New Customers.

Help menu:
Use this menu for learning how to use Customer Appointment Manager, getting online updates,
purchasing additional licenses, finding special offers, and sending feedback.



Customer Appointment Manager

Chapter 3:  Getting Started 11

Note: The Alt Key shortcuts using your keyboard can also be used with each command in your menus.
For example, Alt R opens your Reports menu, and when it’s followed by Alt P, then Alt D, it will print
your Daily Appointment Sheet.

Tool Bar

To access options in your tool bar, navigate to the button with your mouse and click.

Employee Maintenance button:
adding, editing, and deleting employee records.

Customers Maintenance button:
adding, editing, and deleting customer records.

Find Open Time button:
finding an available appointment time.

Search for Appointment button:
searching the calendar for specific information such as customers’ names, employees’ names, or
scheduled appointments.

Waiting List button:
printing, adding, editing, and deleting customer waiting list information.

Today button:
viewing today’s appointment calendar with each employee column.

Day button:
viewing a specific day in the appointment calendar with each employee column.

Week button:
viewing an employee’s appointments in week-format.

Month button:
viewing a summary of  appointments booked versus hours available in a month-format.

Back button:
going back to a previous date, week, or month.

Forward button:
moving ahead to the next date, week, or month.
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Filter button:
condense the employee list that appears on the scheduling worksheet by filtering out employees by
position.

Refresh button (multi-user versions only):
updating the appointment calendar when multiple people can make entries.

Appointment Book

The Customer Appointment Manager appointment book is located in the center of  your screen and has
the appearance of  a typical paper appointment book. You can customize the look of  your book by selecting
the fonts and colors you prefer. You can also use the appointment book to schedule upcoming customer
appointments, employee days off  or duties such as cleaning and stocking shelves.

Calendar

The calendar in Customer Appointment Manager makes it easy to select the date or dates you are viewing
in your appointment book. By simply clicking on a date in your calendar, the appointment book view changes
to that date. You can also use the arrows at the top of  the box to scroll to the month or date you need to
find.

Appointment Details

The appointment details box is located on the left side of  your screen. When you select an appointment in
your appointment book, this box will give you the complete details of  that appointment. At the top of  the
box, Customer Appointment Manager notes the date and time of  the visit. Next, it lists the customer’s
name and phone number, the service requested, and any additional information needed for the appointment
such as a customer’s special needs, allergies, preferences, and so on.

Waiting List

The waiting list box, in the lower left corner of  your screen, displays the status of  your waiting list items.
Clicking the All link allows you to view all customers waiting in the Waiting List window, where you can add,
edit, even schedule your waiting list appointments. The waiting list in Customer Appointment Manager
can be sorted by clicking the column headings or by clicking the Sort button.

Appointment Requests (Pro edition only)

The appointment requests box is located under your waiting list items. It displays the status of  your online
appointment requests that you received via TakeAppointments.com. It displays how many are new and how
many are not yet scheduled, and how many remain in your Inbox with a link you can use to access them.
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You can take your business to the next level with TakeAppointments.com, the online appointment scheduling
and business management tools only offered with Customer Appointment Manager. TakeAppointments.com
allows your customers to request appointments online, even when your business is closed.
You must sign in to use this feature and have the information displayed. Go to Tools in the menu bar and
select Online Appointment Requests.

Database Maintenance

You can backup and restore your customer and appointment data, set data paths to other databases, and
remove old appointments with these maintenance features.

Backup:
Select Backup from the File menu to backup your data frequently. You should keep a backup copy of
the Customer Appointment Manager database in case the files become unusable due to an
unforeseen computer problem. You can use the Backup Reminder feature to alert yourself  to
backup.

Restore:
Select Restore from the File menu to overwrite your current database with the database from your
last backup. For multi-user versions only: Before backing up or restoring your database, please be
sure you are the only user logged into Customer Appointment Manager and all other users are
logged out.

Set Data Path:
Using Set Data Path allows you to refer to databases other than your default Microsoft ® Access ®
database file (C:\Program Files\Customer Appointment Manager\ApptDB.mdb). Select Set Data
Path from the File menu.

Delete Old Appointments:
Select Delete Old Appointments from the File menu. Enter or select a date, and appointments that
occurred before that date will be removed from your Customer Appointment Manager database.
If  you delete old appointments with this procedure, the appointments cannot be restored.

Special Features

Customer Appointment Manager is exceptionally easy to use with many other intuitive features.

Pop-up Appointment Details:
Pop-ups show you details as you browse the appointment book. When space is tight, simply pass
your cursor over an appointment to have its details displayed.
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Drag-and-Drop:
To move appointments, you can place the cursor on the top bar of  the appointment box, then drag-
and-drop it to a new time slot or new employee slot.

Custom Column Widths:
Click and drag the outside border of  employee columns to the desired width. You can select each
individually and adjust as needed.

Sorts:
Various lists provide special sorting options to manage your information, including employee and
services lists. Choose the Sort button and organize by using up and down arrows, ascending/
descending orders, and other choices in drop-downs, such as Sort by last name and Sort by position.

Network Wizard:
From the File menu, select Network Wizard to assist in locating a shared Customer Appointment
Manager database (multi-user version only).

Print Calendar View:
From the File menu , select Print to print the daily, weekly, or monthly calendar view of  your ap-
pointment book.

Right-Click Menus:
Right-click appointments, list fields, or hours tables for quick access to options such as cut, copy,
paste, and delete. Also right-click appointments to view or print the Appointments Report, create
QuickBooks invoices and view the status of  the appointment.

Edit > Undo:
You can select Undo from the Edit menu to reverse an action taken, including a delete, move, cut,
paste, or resize.

Active Mouse Wheel:
Quickly scroll the appointment calendar using your mouse wheel.

Zoom:
From the View menu, select Zoom to choose the view size of  your appointment book.
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Getting Help

If  you have any questions about Customer Appointment Manager, please refer to the Help topics or
contact our Technical Support department as follows:

l Internet http://www.abs-usa.com
l Email support@abs-usa.com
l Phone 1-701-235-5226

Monday through Friday
8:00 am to 5:00 pm central time

Free Technical Support Period:
ABS offers 90 days of  FREE technical support to registered Customer Appointment Manager users. Free
technical support starts from your date of  purchase. Thereafter, there is a $35 charge per incident. ABS also
offers 12-month, unlimited Technical Support Plans and Software Enhancement Licenses. For just pennies a
day, we can help keep your software up and running.

Support Plans:
Unlimited telephone and e-mail access to ABS Support Technicians and FREE media replacement should
your software become lost or damaged. For Support Plan pricing, please call 1-800-874-8801.

Software Enhancement Licenses:
ABS offers 12-month, Software Enhancement License entitling you to FREE upgrades, in addition to every-
thing included in a Support Plan. For Software Enhancement License pricing, please call: 1-800-874-8801.
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